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Thank you for purchasing Brother's PT-2040. Use your new PT-2040
label maker to create labels for multiple applications. Select from the
many frames, character sizes, and styles to design beautiful custom
labels. In addition, the variety of Tape Cassettes available allows you
to print labels with different widths and exciting colors.

Please read this guide, including all Precautions, before using
this machine. After reading this guide, keep it in a safe place.
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General Precautions

* Depending on the location, material, and environmental conditions,
the label may unpeel or become irremovable, the color of the label
may change or be transferred to other objects. Before applying the
label, check the environmental conditions and the material.

* Do not use the label maker in any way or for any purpose not
described in this guide. Doing so may result in accidents or
damage the label maker.

» Use Brother TZe tapes with the label maker. Do not use tapes

that do not have the mark.

* Only use a soft, dry cloth to clean the label maker; never use
alcohol or other organic solvents.

* Use a soft, lint free cloth to clean the print head. Never touch the
print head directly with your hands.

* Do not put any foreign objects into the tape exit slot, AC Adapter
connector, battery compartment, etc.

* Do not place the label maker / batteries / AC Adapter in direct
sunlight or rain, near heaters or other hot appliances, in any
location exposed to extremely high or low temperatures (e.g., on
the dashboard or in the back of your car) or high humidity, or in
dusty locations.

* Do not apply excessive pressure to the Tape Cutter Lever.

* Do not try to print if the cassette is empty; it will damage the print
head.

* Do not pull the tape while printing or feeding; it will damage the
tape and the label maker.

* Any data stored in memory will be lost due to failure, repair of the
label maker, or if the battery expires.

* The label maker is not equipped with a charging feature for
rechargeable batteries.

* The printed text may differ from the text that appears on the LCD.

* The length of the printed label may differ from the displayed the
label length.

* A protective clear plastic sticker is placed over the display during
manufacturing and shipping. This sticker should be removed prior to use.

* When power is disconnected for more than five minutes, all text,
format settings and any text files stored in the memory will be
cleared.

Safety Precautions

Indicates a potentially
AWARN I N G hazardous situation which, if

not avoided, could result in

death or serious injuries.

Follow these guidelines to avoid the risk of fire, burns,
injury, electric shocks, rupture, overheating, abnormal
odors or smoke.

* When the label maker is not being used, store it out of the reach
of children. In addition, do not allow children to put the label maker
parts or labels in their mouths. If any object has been swallowed,
seek medical attention.

* Always use the specified voltage and the suggested AC Adapter
(AD-24ESA-01/AD-24ESAW-01) for the label maker to prevent
any damage or failure.

+ Do not touch the label maker during a lightning storm.

* Do not use the label maker / AC Adapter in places of high
humidity such as bathrooms.

* Do not overload the power cord.

* Do not place heavy objects on, or damage the power cord or
plug. Do not forcibly bend or pull the power cord. Always hold the
AC Adapter when disconnecting from the power outlet.

» Make sure that the plug is fully inserted to the power outlet. Do not
use an outlet that is loose.

* Do not allow the label maker / AC Adapter / power plug / batteries
to get wet, for example, by handling them with wet hands or
spilling beverages on to them.

* Loss of eyesight may result when leaked fluid from batteries gets
into your eyes. If leaked fluid gets into your eyes, immediately
rinse your eyes with a large amount of clean water, and then
immediately seek medical attention.

* Do not disassemble or modify the label maker / AC Adapter /
batteries.

* Do not allow metal objects to contact the battery.

* Do not use sharp objects, such as tweezers or a metallic pen, to
change the batteries.

* Do not throw the batteries into fire or expose to heat.

* Disconnect the AC Adapter and remove batteries immediately
and stop using the label maker if you notice abnormal odor,
heat, discoloration, deformation or anything unusual while using
or storing it.

* Do not use a damaged or leaking battery as the fluid may get on
your hands.

* Do not use a deformed or leaking battery or one whose label is
damaged. There is a possibility of generating heat.

Indicates a potentially

ACAUTIO hazardous situation which, if

not avoided, may result in

minor or moderate injuries.

Follow these guidelines to avoid personal injury,
liquid leakage, burns or heat.

* Do not touch metal parts around the print head immediately after
printing.

* Do not touch the cutter blade.

* If leaked fluid from batteries gets on your skin or clothes,
immediately rinse them with clean water.

* Remove the batteries and disconnect the AC Adapter if you do
not intend to use the label maker.

* Do not use a battery other than that specified. Do not use
combinations of old and new batteries or combinations of
different types, different charging levels, different manufacturers
or different models. Do not insert a battery with its plus and minus
ends reversed.

* Do not drop or hit the label maker / AC Adapter.

* Do not press on the LCD display.

* Do not put your finger inside the label maker when you close the
Cassette Cover.



ED GETTING STARTED

Installing Power Supply

Installing a Tape Cassette

<=

>

Battery Compartment

When using AC Adapter
(AD-24ESA-01/
AD-24ESAW-01):

1. Insert the Power
Adapter cord into the AC
Adapter Jack on the side
of the machine.

2. Insert the Power
Adapter into a standard
AC electrical outlet.

When using batteries:

1. Make sure the power is
off.

2. With the LCD facing
down, remove the Battery
Compartment Cover by
pressing the grooved tab
and pushing in the
direction of the arrow, as
illustrated.

3. This label maker
requires six (6) AA
alkaline batteries, not
included.

Make sure that the
positive (+) and negative
(-) ends of the batteries
match the marks inside

the battery compartment.

Note:

Always replace all six
batteries at the same time
using brand new ones.

4. Attach the Battery
Compartment Cover by
inserting the three hooks
at the bottom into the
slots on the machine, then
press down firmly until it
clicks into place.

When running a memory
backup, we recommend
using both the Power
Adapter AND batteries, in
the event that one or the
other power method fails.

Exit Slot

Release
Lever

1. Open the Cassette
Cover by lifting both sides
at the same time.

2.Insertthe Tape Cassette
following the drawing

7l marked inside the case.

Gently press the Tape
Cassette into the label
maker until it clicks into
place.

* Use only tape widths of
0.13" (3.5 mm), 0.23"

(6 mm), 0.35" (9 mm),
0.47" (12 mm) or 0.70"
(18 mm).

* If your TZe tape is
packaged with protective
plastic, be sure to remove
the plastic before inserting
the Tape Cassette.

» Use Brother TZe tapes
with this machine.

3. Close the Cassette
Cover and gently press

—> | until it clicks into place.




LCD and Keyboard
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» Removing the protective film
e To protect your machine from scratching
29 ? ,  during shipping, a protective film was placed
281 , on the LCD.
l 4 & A T ) © N\ Il ;  Make sure to remove the protective film
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1. Tape Cutter Lever 15. Space key @ NOTE D
2. Width 16. Auto Format (A/F) key  « The LCD displays one row of 15 characters;
3. Power key 17. Symbol key however, there is a maximum of 80 characters
4. Underline / Frame 18. Caps key (including spaces, tabs, symbols, and a return) for
5. Style 19. Tab key a label.
6. Cursor key 20. Character key * When selecting the settings, press to
7. Function (Fn) key 21. Preview key return to the default item.
8. Clear key 22. Font1 key * Pressing the Preview key (21) displays a
9. OK key 23. Font2 key preview of the label, and may differ from the
10. Escape key 24. Feed/Print key actual label when printed.
11. Backspace key 25. Caps « Label length shown on the LCD may differ
12. Enter key 26. Label Length slightly from the actual length when printed.
13. Shift key 27. Cursor
14. Accent key 28. Font
29. Size



Supplies and Accessories

Initial Settings

For a complete list of tapes compatible with your
machine, see your model’s page at
support.brother.com.

Tape

Cassettes: Brother TZe tapes with IZe mark.
0.13" (3.5 mm), 0.23" (6 mm),
0.35" (9 mm), 0.47" (12 mm),
0.70" (18 mm)
See the included Supplies and
Accessories Guide.

AC Adapter: AD-24ESA-01/
AD-24ESAW-01

Print Head

Cleaning

Cassette: TZe-CL4

Specifications

Dimensions: Approx. 6.5" x 8.6" x 2.7"

(W x D x H) (Approx. 164 mm x 218 mm x 58 mm)

Weight: Approx. 1.3 Ib. (Approx. 570 g)
(without batteries and Tape Cassette)

Power Supply: » AC Adapter (AD-24ESA-01/

Tape Cassette:

AD-24ESAW-01)
+ Batteries (not included)
Six AA alkaline batteries (LR6)

Brother TZe tape (width)
0.13" (3.5 mm), 0.23" (6 mm),
0.35" (9 mm), 0.47" (12 mm),
0.70" (18 mm)

For FAQs and to download manuals, visit:
support.brother.com.

1 Turn your machine on.
Supply power by using the AC Adapter
(included) or six AA batteries (not included),

and then press .

2 Set the language.
The default setting is [Eng1ish].

> |- ﬂ »)) [Language] >

(Select a language) | ok ).

3 Set the unit of measurement.
The default setting is [inch].

> (-} [onit]
> (- ﬂl » ) [inch / mm] [ ok ).
@ NOTE D

» The machine automatically turns off if no keys are
pressed within five minutes.
« To cancel any operation, press (s |.
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) BASIC USAGE

Entering Text

You can enter a maximum of 80 characters
(including spaces, tabs, symbols, and a return) for
a label.

» Switching Upper Case / Lower Case

Upper case Lower case
([cae] ON ([cae] OFF
ABC_ abc_

» Creating Two-Line Labels
Move the cursor to where you want to start the next

line and press . Use either 0.35" (9 mm), 0.47"

(12 mm), or 0.70" (18 mm) tape for two-line printing.

@ NOTE D,
* The return symbol () appears when you press

the Enter key

Display Label image
- - abc
abcddef def
» Entering Tabs

Move the cursor to where you want to set a tab
and press ().

@ NOTE D,
* The tab symbol [} appears when you insert a
tab in the text.

Display Label image

obcld_ abc d

> Changing Tab Length

(Fn ) > [Tab Length] m

[Auto/0.0"-4.0" (0 mm-100 mm)
* To return to the default tab length, press

* Please note: the default length varies based on
your tape size.

» Cursor Keys
To move to the end of your text:

oo+

To move to the beginning of your text:

oo+

» Entering Accented Characters

- -)[Accent]-)[Accent}/ -)@

» Refer to the Accented Characters table in this
guide.

* The order of accented characters varies based
on the language you selected.

» Changing Label Length

(Ffn ) => [Label Length] >

Q[Auto/l 2"-12.0" (30 mm-

300 mm)] o)
@ NOTE D)

» V¥ appears in the Label Length area when you
set a specific label length.

 Toreturn to the default length (automatic, based
on text length), press|  seee ], and [Auto]
appears on the LCD.

P Clearing Text and Settings
To delete individual letters and spaces, press [&|.
To delete all text:

(clar) = (< | >} [Text Only][ok)

To delete all text and settings:

> [Text & Format]




Printing Labels

» Preview

* Pressing the Preview key displays all of the text
and the label length, then returns to the original
text.

* Only the text can be previewed, not the font,
style, size, underline/frame or any additional
features.

» Feeding (Tape Feed)

Feed
sshift| + { Print

* This function feeds approximately 1" (25 mm)
of blank tape.

* When using the Chain Print feature, after the
last label is printed, feed the tape.

* Do not pull the tape, as this may damage the
Tape Cassette.

» Printing

( Fae ) »lset 1-920 (]~ /[ )-[s]
> [ oK)

* If you need only one copy of the label, press

after you press .

* You can print up to nine copies of each label.

* DO NOT touch the Tape Cutter Lever while the
message [Print] or [Feed] appears on the
LCD.

* To cut tape: When printing ends, press the
Tape Cutter Lever.

» To remove tape backing, fold the label
lengthwise (with the text facing inward), to
expose the inside edges that run down the
center of the tape backing. Peel and apply.

» Using Print Options

[Numbering]

You can print a series of up to 10 labels using

auto-numbering. Use this feature to automatically

increase a selected number by 1 after each one is
printed.

Ex: Print copies of labels containing a serial

number (0123, 0124, and 0125)

(Enter numbers) = ((« ﬂ » ) by moving the
cursor to the number you wish to increment.

pizg > > [Print
Option] > [Numbering]
> Set 3-975

+ Select the highest number you wish to print
when setting the number.
[Mirror]
Ex: To Mirror Print "J.SMITH", follow the
instructions below after entering "J.SMITH".

T2NILH

(Enter text or characters) -» >

[Print Option] > (- ﬂ ») [Mirror]
< [Mirror Print?]

 Use clear tape when using this function, so the
labels can be read correctly from the opposite
side when attached on glass, windows, or other
transparent surfaces.



Setting Margins

The laminate mechanism creates a margin of
about 1" (25 mm) at the beginning of printing. You
can reduce this margin by printing labels
continuously.

You can also change the margin before and after
the text.

(Ffm)> <ﬂ> [Margin] [ok) <

[Full/Half/Narrow/Chain Print]

P [Full]/[Half]/ [Narrow]
 The printed dots (:) indicate the end of the label.
Cut along the printed dots (:) with scissors.

m When printing a single sheet:

abc
Full
1 ] 1 ]
1" 1"
(25 mm) (25 mm)
|
Half 1 abc
L1
1" 0.47" 0.47"
(25 mm) (12 mm) (12 mm)
X
Narrow ;| abc
L
1" 0.16" 0.16"

(25 mm) (4 mm) (4 mm)

m When printing multiple sheets:

Full abc : abc

(25 mm) (25 mm) (25 mm)

X X X
A A A

Half | abc |:| abc

1" 0.47" 047" 047" 047"
(25 mm)(12 mm) (12 mm) (12 mm) (12 mm)

X X X
L i\ i\

Narrow :| abc |:| abc |:

1" 0.16" 0.16" 0.16" 0.16"
(25 mm)(4 mm)(4 mm)(4 mm) (4 mm)

When selecting Half and Narrow margins, a
mark will immediately follow the margin of about
1" (25 mm) indicating where to cut the label.

P [Chain Print] (Tape-saving option)
Use this option to print multiple labels with the
narrowest margins. This feature saves tape.
Select [Chain Print] for the margin.

This setting does not print dots (:) indicating the
end of the label. Use scissors to remove any part
of margin that is not required.

1. Enter the text.

2. Press . The message [Set 1-921]
appears on the LCD.

3. Press the number keys to enter the amount
of copies you want to print.

4. Press to start printing.

5. Clear the text and re-enter the text you want
on the next label.

6. Repeat steps 2 through 5.

7. After the last label prints, feed the tape by

possing [ssn]and (G ).

8. Press the Tape Cultter Lever.

@ NOTE D
» Once the final label sheet prints, feed the tape

before pressing the Tape Cutter Lever ( +

), otherwise part of the text may be

cut off.
* Do not pull the tape, as this may damage the
Tape Cassette.




Setting Margins (cont)

Saving Labels Files

m When printing multiple copies
(2 to 9 copies of the same text):

abc abc abc

Chain
Print I L LI <Feed and Cut>
1" 0.16" 0.16"
(25 mm) (4 mm) (4 mm)
(ref) : abc : abc : abc
Narrow L1 1 1 1 1 L1

1" 0.16" 0.16" 0.16" 0.16" 0.16" 0.16"
(25 mm)(4 mm)(4 mm)(4 mm)(4 mm)(4 mm)(4 mm)

Once the final sheet prints, feed the tape, and
press the Tape Cutter Lever.

m When printing multiple labels (different text):

Chain abc def ghi
Print 1 ] 1 ] 1 I <Feed and Cut>
1" 0.32" 0.32"
(25 mm) (8 mm) (8 mm)
. abc
(ref) 1 1 L
Narrow " 016" 0.16"
(25 mm) (4 mm) (4 mm)
. def
1 1 L
1" 0.16" 0.16"
(25 mm) (4 mm) (4 mm)
. ghi
1 1| L
1" 0.16" 0.16"

(25 mm) (4 mm) (4 mm)

The printed labels will have the narrowest margin
width when you use Chain Print. While the printed
text is still inside the label maker, do not feed the
tape until the final label is printed.

Once the final label prints, feed the tape, and press
the Tape Cutter Lever.

You can save and reuse the text and settings for
up to five different labels. Each label holds up to
80 characters (including spaces). Assign a
number (1-5) to each saved file so you can reuse
it, and edit or overwrite stored files as needed.

» Saving a new file

(Enter text) > [File] >

[Save] (06) [ - loiv
@ \OTE D

* When saving afile, if you reuse a number that is
already assigned to anotherfile, [Overwrite?]
appears on the LCD. To overwrite the

previously-saved file, press [ o« ). To cancel
without saving, press (Esc .

P Printing a saved file

> [File] > [Print]

> (<] >) w1 P-toucn >

[Set 1—9?1]/@ o] > [ oK)

» Opening a saved file
> [File] > (<] ) [open]
> 1% P—touch




E) USING TEMPLATES

Auto Format

You can choose from six preset label lengths to
create labels for various applications.

> (<] ) (Select a format) [ o« )

Applications Label Lengths
CD Spine 45" (113 mm)
DVD Spine 5.8" (148 mm)
USB Stick 1.3" (34 mm)
Binder Spine 7.9" (200 mm)
File Folder 4.7" (120 mm)
Divider Tab 1.6" (42 mm)

£} DESIGNING LABELS

Setting Font

Display Label image

Fl: Hel=inki Helsinki 123

Display

F2: Usnezino

Label image

Venezia 123

@ NOTE D
* The actual printed font size depends on the

tape width, number of characters and number
of input lines. Once characters reach a
minimum size, the selected font will default to a
custom font which is based on the Helsinki
style. This allows tapes to be printed using the
smallest text possible on narrow or multi-line
tapes.

Setting Font Size

> (|« ﬂl > [Size] =» [Large/Medium/
Small/MAX]| OK )

Label image
[Large] [Medium]
ABCxyz ABCxyz
[sma11] [Max]
ABCxyz ABCXYZ
@ NOTE D

» Automatically adjusts the text size according to
the tape width.

* The actual printed font size depends on the
tape width, number of characters and number
of input lines.

» Select MAX to print with maximum text size
when using 0.70" (18 mm) tape, text is all Upper
Case, the Style setting is [Normal], and the
Underline/Frame setting is [O0f £].



Setting Font Width

Setting Underline/Frame

> [width][ 0K ) < [Normal/x 2/x
1/2][ oK)

Label image
[Normal] [x 2] [x 1/2]

abc abc i

Setting Font Style

Refer to the Frame Designs table section in this
guide.

> [Underline/Frame] >
(Select an item)

@ NOTE

* When using 0.13" (3.5 mm) tape, only
[Underline]is available.

> [style][ oK) = (Select an
item)

Label image
[Normal] [Bold]

abc abc

[Outline] [Shadow]
206 206
[tta1ic] [ttalic Bold]

abc abc

[Ttalic out1](ltalic Outine) [Ttalic shadow]
g0ac abe
[Vertical]

©c O O

Setting Symbol

Press to select various symbols. Refer to
the Basic Symbols and Pictograph Symbols

table sections in this guide.

-> [Basic/Pictograph] ->

(Choose a symbol)

@ NOTE

» To go to the next group, press .



£} HELPFUL HINTS

Shortcuts

Size > (a]
Width >
Style >
Underline/Frame - (D]
File > [E]
Label Length >
Margin >
Tab > [H]
Tab Length > (1]
Print Option >
Auto Format >
Language >
Unit <> [v]

Helpful Tips

Feed

Feed

Cancel Operation

or

Resetting the Machine

Reset your label maker when you want to initialize the
settings or in the event it is not working properly.

Resetting clears all the text, settings, and stored files.
It also clears the language and unit of measurement

settings.

1 Turn off the label maker, hold down

and (Esc |, and then press () to

turn the label maker back on.

2 First release the power button, and then

release and (Esc |.

The label maker turns on with the internal
memory reset.

If you encounter any problems with your
product, please do not return your product to
the store.
After referring to the User's Guide, if you still
need assistance or need to locate a service
center, contact Brother Customer Service at:

(In USA)

Voice: 1-877-BROTHER

Web: www.brother-usa.com

Fax: 1-901-379-1210
To order supplies and accessories, visit
www.brothermall.com or call
1-877-552-6255.

@ NOTE

A\ CAUTION

* Remove the batteries if you do not intend to use
the label maker for an extended period of time.

* Dispose of batteries at an appropriate
collection point, not in the general waste
stream. Be sure to observe all applicable
federal, state, and local regulations.

* When storing or discarding a battery, wrap it
with cellophane tape, to prevent it from short-
circuiting. (See illustration)

1. Cellophane tape

2. Alkaline battery
Do not mix old and new 1
batteries. Replace all six batteries at the
same time.



https://www.brother-usa.com
http://www.brothermail.com

Troubleshooting

» Error messages

» What to do when...

Message

Cause / Remedy

Invalid!

* There is no text above the cursor when you
selected [Numbering].

* An invalid character was selected for
[Numbering].

* An invalid value was selected for [Tab
Length]or [Label Lengthl].

* An invalid value was entered as the label
length while using templates.

No Text!

* You tried to print a text file when there was no
data stored in the memory.

* You pressed when no text was

entered.

* You selected [Print Option]when no text
was entered.

* You pressed when no text was

entered.

Problem Solution
The display » Check that the AC Adapter is correctly
stays blank connected.

after you have
turned on the
machine.

* Check that the correct AC Adapter
(AD-24ESA-01/AD-24ESAW-01) is used.

 Check that the batteries are correctly
inserted.

* The batteries may be weak. Replace them.
 Check that the protective film is removed.

Line Limit!

* You tried to enter a 3rd line by pressing .

* You tried to print or preview two lines of text
while 0.13" (3.5 mm) or 0.23" (6 mm) tape
was installed. Install a larger tape size.

No Cassette!

Install a Tape Cassette.

Cutter Error!

The Tape Cutter Lever was pressed in the
middle of the printing process.

When the label
is printed, there
is too much
margin (space)
on both sides of
the text.

* Refer to the Setting Margins section in this
guide and select [Half], [Narrow]or[Chain
Print] for smaller margins.

Due to the structure of the laminate, when you
set[Half]or [Narrow], the label maker feeds
approximately 1" (25 mm) of leader tape
before every new label.

To save tape, set [Chain Print]. After the

last label prints, press and
to feed the tape, and then press

the Tape Cutter Lever.

* Check if ¥ appears in the Label Length area.
If so, Auto Format or label length is set. Set
Auto Format[of f]and label length [Auto]. Or
reset the machine. Refer to the Resetting the
Machine section in this guide.

Text Full! |The text exceeds the maximum number of
characters (80 characters).

Text Too * The text length exceeds the selected label

Long! length or the selected Auto Format setting

length.

« Select a longer label size or [aAuto] for a
longer label length. Refer to the Changing
Label Length section in this guide.

« Select a longer preset label format in Auto
Format. Refer to the Auto Format section in
this guide.

*» Select[x 1/2]font size. Refer to the Setting
Font Width section in this guide.

No Frame OK?

Printing on 0.13" (3.5 mm) tape with an invalid
Frame setting ON. (Select to print with

no Frame, @ to cancel.)

The machine |+ Check that the Tape Cassette is inserted
does not. print, correctly.
orthe printed | . Replace the Tape Cassette if striped tape is
cha;acters are | visible, as this indicates that you have
n?g c;rr:ned reached the end of the tape.
propefly.-  Check that the Cassette Cover is closed
correctly.
« Clear the format settings. Press and
select [Text & Formatl].
* Reset the machine. Refer to the Resetting
the Machine section in this guide.
The setting has |+ Check that the AC Adapter is correctly

cleared on its
own.

connected.
* The batteries may be weak. Replace them.

» When the power is disconnected for more
than five minutes, all text and formats in the
display settings will be cleared.

Battery The batteries are weak.

Weak! If using alkaline batteries, replace them with
new ones.

Check The installed batteries are running low and

Battery! need to be replaced for continued operation.

The machine is

Reset the machine. Refer to the Resetting the

locked and Machine section in this guide.

nothing

happens when

keys are

pressed.

The power  Check that the AC Adapter is correctly
turns off when connected.

you try to print. |« Check that the correct AC Adapter

(AD-24ESA-01/AD-24ESAW-01) is used.
 The batteries may be weak. Replace them.
 Check that the batteries are correctly inserted.




Troubleshooting (cont)

Problem

Solution

The ink ribbon
is separated

If the ink ribbon is broken, replace the Tape
Cassette. If not, leave the tape uncut and

from the ink remove the Tape Cassette, then wind the loose
roller. ink ribbon back onto the spool.

Spool
The tape does |+ Check that the end of the tape feeds under
not feed the Tape Guide.

properly or the
tape gets stuck

inside the
machine. 0: - Tape Guide
0 \
s Ué}%/ End of Tape
* The Tape Cutter Lever is pressed while
printing. Do not touch the Tape Cutter Lever
during printing.
While printing, | The Tape Cassette is empty. Inserta new Tape
striped tape Cassette.
appears.
All text and
Cl .
format settings Press and select [Text & Format]
need to be
cleared to

create a new
label.

A blank
horizontal line
appears
through the
printed label.

* There may be some dust on the Print Head.
Remove the Tape Cassette and use a dry
cotton swab to gently wipe the Print Head with
an up-and-down motion.

* The Print Head can be cleaned more easily if
the optional Print Head Cleaning Cassette
(TZe-CL4) is used.
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Federal Communications Commission (FCC) Supplier’s Declaration of Conformity (USA)

Responsible Party: Brother International Corporation
200 Crossing Boulevard
Bridgewater, NJ 08807-0911, U.S.A.
TEL: (908) 704-1700

Product Name: Label Writer
Model Number: PT-2040

This equipment complies with Part 15 of the FCC Rules. Operation is subject to the following two
conditions: (1) This equipment may not cause harmful interference, and (2) this equipment must
accept any interference received, including interference that may cause undesired operation.

This equipment has been tested and found to comply with the limits for a Class B digital device,
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection
against harmful interference in a residential installation. This equipment generates, uses and can
radiate radio frequency energy and, if not installed and used in accordance with the instructions, may
cause harmful interference to radio communications. However, there is no guarantee that interference
will not occur in a particular installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the user is
encouraged to try to correct the interference by one or more of the following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the equipment and receiver.

» Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
 Consult the dealer or an experienced radio/TV technician for help.

Important

Changes or modifications not expressly approved by Brother Industries, Ltd. could void
the user's authority to operate the equipment.
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DON’T FORGET TO REGISTER!

If you complete and submit your registration, your product will be officially registered with
Brother International Corporation and you’ll automatically be entered into our monthly
$1,000 “Click To Win” contest.

Registering your product will provide purchase confirmation, proof of ownership and, if you
choose, allows us to notify you of product enhancements and special offers!

Simply fill out the enclosed warranty card or if you prefer, you can register on-line
by visiting us at:

www.registermybrother.com

* Sweepstake open to legal U.S. residents 21 years of age and older.

* Subject to all federal, state, and local laws and regulations. Void where taxed, prohibited, or otherwise
restricted by law.

* See Web site for complete details.
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